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We need your feedback! 

 
This guide is being updated weekly. Please provide your 

feedback to danz@elks.org. We will be glad to add 

additional instructions/explanations/clarifications that 

would be of general interest. 
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YOUR COMPUTER EQUIPMENT 
 

POWER 

ISOBARs should never be used to provide electricity for other devices heaters, 

fans, vacuum cleaners, etc. should not be plugged in to the power strip.  The 

ISOBAR is designed to protect electronic equipment from the above devices and 

plugging them into the same power strip basically defeats its purpose 

YOUR COMPUTER 

LOGON 

Every staff member has their ELKSHQ USERNAME and PASSWORD (Keep 

your password confidential). When your computer has powered up, you will see 

instructions to PRESS CTRL-ALT-DELETE TO BEGIN. This may sound a little 

confusing, but if you look at your keyboard you will see on the bottom row of keys 

a CTRL key, and an ALT key. On the right hand side of the keyboard you will see 

a row of keys between the numeric keypad and the letters; this is where the 

DELETE key is located. 

 

When logging on, be sure you are not logged on elsewhere. Log off 

other PC’s to avoid conflicts.  
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Enter elkshq\ USERNAME and PASSWORD into the correct areas. Finally, when 

you have entered your details, click on the arrow button or press ENTER on the 

keyboard. After your first logon you may not be prompted for the domain (elkshq\) 

and you can just enter your user name and password or if it is easier to remember 

you can just enter elkshq\ USERNAME and PASSWORD each time 

SHUTTING DOWN, RESTARTING LOGGING OFF COMPUTER  

 To insure a consistent environment logoff will always require either a restart or 

shutdown, you can’t simply logoff. Log off any Citrix Apps remote sessions before 

you shutdown/restart your PC.    

Before logging off  

1. Please do not use the start menu and select restart or shutdown, because 

the log off script will not run potentially hanging your computer and your 

PC will not restart or shutdown. 

2. Also never shut down your PC by holding or pushing the power button 

on the PC, this will eventually damage your profile and disable your PC 

 

3. Before you shut down or restart your PC you should close any applications 

you have open. This is done by either:  

• Clicking on the File menu within the application and then selecting 

EXIT (ALT + F4 is the keyboard shortcut for this function); or  
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• Click on the CLOSE button located on the top right hand side of the 

application.  

 
 

4. REMOVE USB DRIVE - You should also remove any USB (thumb) 
drives from your computer. To eject and remove any USB drives open up 

Windows Explorer by double clicking the Windows Explorer shortcut on the 

desktop. 

 

Locate the USB drive name in the FOLDER LIST and right mouse click on 

the drive, then select EJECT from the shortcut menu. This will ensure that 

the drive is removed correctly without damaging any files it contains.  

 
 

 
                              

Logging Off  

1. Click on the Logoff button on the desktop  

 
 

2. Windows will open asking you to select R for reboot or S to shut down. 
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3. Make your select and then press the enter key  

4. The log out process will then start. 

 

LOCK PCLOCK PCLOCK PCLOCK PC - Locking your Workstation  

When you leave your workstation temporarily, it is important that you lock it so 

that no-one else can access the system 

using your username and password. To 

lock your workstation use the same 

keys that you used to log on ie CTRL, 

ALT and DELETE keys.  

 

• Press the CTRL, ALT and DELETE 

keys simultaneously;  

• The Windows Security dialog box 

will appear;  

• Click on LOCK COMPUTER  

• OR PRESS  + L.  

 

A COMPUTER LOCKED dialog box which says that your computer is in use and 

has been locked appears. 
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UNLOCK PC 

Unlocking Your Workstation  
To unlock the computer;  

• Press the CTRL, ALT and DELETE keys simultaneously;  

• Type in your Password in the PASSWORD field, just as you did when you 

originally logged on.  

 

NOTE: Remember, it is always best to lock your workstation when you leave it 

unattended so that no-one else can use your username and password.  

 

Windows 7 Update Notifications 

You may at times be prompted to update your Windows 7 desktop either by a 

popup that appears in the lower right hand corner of the task bar or you may see it 

from the start menu.  Your computer will be updated during its regular quarterly 

deployment schedule but we’ll try to keep windows patches updated during the 

interim. So if provided the option allow the update process to proceed.  Be careful 

not to turn off the computer while updates are being applied.  

 

Software registration prompts 

You may periodically encounter prompts asking you to register your applications 

such as DYMO, ESE, Adobe or other products.  When prompted and if provided 

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 12 of 102 

 

with the option to not remind you again to register this product, please do 

so.  Otherwise if prompted to register some specific application simply click the 

cancel button when available.  If you continue to have issues with this contact the 

helpdesk so that they may instruct you on how to handle this situation.   

Password Expiration Notice 

PASSWORD CHANGE NOTIFICATIONS - For the User 

Passwords will expire every 90 days and you will be required to create a new one 

at that time.  Failure to comply can cause long delays in gaining access to your 

system.  As you get closer to your password deadline, you will be informed via 

email as in the example blow.  IMPORTANT – When you change your login in 

password it is highly advisable that you also change you email password see 

section CHANGING EMAIL PASSWORD 

 

Please wait 30-60 minutes before they try logging in again to insure that all of 

the domain controllers are synchronized with their passwords.  Ultimately the 

best plan is to change passwords at the end of the day and then log off that would 

give the domain controllers all night to synchronize before they log on again.   
 
From: helpdesk@elks.org [mailto:helpdesk@elks.org]  

Sent: Friday, September 27, 2013 7:28 AM 

To: User Name 

Subject: Important: Password Expiration Notification - elkshq.net 

 

Hi UserName, 

 

Your password for account "UserName" expires in 3 day(s). Please change the password as soon as possible to prevent 

further logon problems. 

 

Click the following link to change your password now: Enterprise edition only.  

 

NOTE: Refer to the BPOE HQ Network User Guide for instructions on changing your password. Also change your Intermedia 

email password at the same time so you are not unintentionally locked out in the future  

---------------- 

This is an automatically generated message from our Password Expiration Notifier.  

 

---------------- 

This is an automatically generated message from NetWrix Password Expiration Notifier.  
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PASSWORD CHANGE NOTIFICATIONS - For the Supervisor   

If you are a supervisor you will also be notified by email when one of your 

subordinate’s password is about to expire. 

 
From: helpdesk@elks.org [mailto:helpdesk@elks.org]  

Sent: Friday, September 27, 2013 7:28 AM 

To: Supervisor Name 

Subject: Password Expiration Report - elkshq.net 

 

This is an evaluation version (20 days left). Request a quote 

 

Passwords and/or accounts of the following users are about to expire: 

 

 

Password Creation Policy 

The Password policy changed slightly please be aware of the new 
composition rules set by Microsoft for secure domain logins. 
 
The password may not contain your account name or parts of your 
username that exceed 2 consecutive characters. 
 
The password must be at least 15 characters in length. 
 
The password must contain characters from any three of the following four 
categories: 
1) Upper case A-Z 
2) Lower case a-z 
3) Digits 0-9 
4) Special characters !,$,#,% 
 
We suggest that you use password phrases that make sense to you so 
they are easier to remember like  
 
Ihagvlo15!Hyho  
 
which could stand for: 
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I had a great vacation last october 15! Hope you had one 
 

How to Change your Login Password 

1. On your keyboard press Ctrl +Alt + Delete keys on your key board 

simultaneously 

 
 

2. You will then be prompted to provide your Old password and New 

password, then you must retype your New password again in the Confirm 

password box.   
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Paylocity:  

To log on to Paylocity select the Paylocity button  on the left side of our intranet 

page and enter the information provided to you by HR if you are having issues 

logging into Paylocity please contact HR. (if you are logging on to paylocity from 

outside the network you will be challenged with additional personal 

informational prompts) 

 
 

Display Settings – Configuring Your Screen 

Changing your text and other items larger or smaller 

It is recommended that if you choose to adjust this setting from its default that you 

do prior to changing your desktop resolution as this may negate the need to make 

any further adjustments.  

1. Right click on your desktop and select Screen resolution 

2. From the screen that appears click on the blue text below “Make text 

and other items larger or smaller”  

 
3. On the next screen you can change the size setting as needed the default 

is “Smaller – 100% (default) 
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4. You will need to log off to apply changes.   

Changing your desktop resolution: 

1. Right click on your desktop and select Screen resolution 

   
2. Select the desired resolution from the sliding Resolution bar  
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3. Click the Apply button after you have made your choice. 

4. Click the Keep changes button if you want to keep this new resolution or 

click the Revert button to put back to previous setting.   

 
5. Next time you restart the notation in the upper right hand screen will reflect 

the new screen resolution at startup. See below. 
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Changing Icon Size - To increase or decrease the physical size of the icons on 

your desktop simply right click on an empty space of your desktop as previously 

indicated and choose one of the three available sizes Large icons, Medium icons 

(default) and Small icons.   

 

 

POWER SETTINGS 

In the event that you are having issues with being locked out or screen time outs 

you can adjust your power settings as follows.   

1. From the Start Menu Click Control Panel  

 

2. From Control Panel Click on Hardware and Sound 

 
3. Click on Power Options 
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4. Click on the Change plan settings link 

 

5. You can now change your time settings for the display and sleep settings.  

  

 

Email 

Important:  For any mass mailings over 25 recipients, consider using constant 

contact or similar bulk mail providers that would comply with the CAN-SPAM 

Federal Act. Sending mass emails from Intermedia Mailboxes is a VIOLATION of 

service terms and can lead to service interruption or closing of our account.   

 

PST Files – How to use 

It is not commonly known that we have 2 replicas of the file server in the 

environment now; FS01 & FS02.  This is a fairly new development and is part of 

the project to move some critical servers to an offsite datacenter to save money and 

provide better up-time for the organization’s IT infrastructure. 
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FS01 will be used to support file server access for our local users connecting via 

the local PCs, FS01 will remain onsite so that local users retain fast access to files. 

FS02 will be used to support VPN desktop access and all citrix desktops sessions 

launched from HQ or remotely, FS02 will be located in a remote datacenter where 

the remote access desktops will also reside as well as the database servers and 

webservers. 

FS01 & FS02 will be kept in sync by replication software 24x7 with one 

exception. 

Important:One precaution that we need to advise you of pertains to the outlook 

archive PST files.  There will be a copy of each PST file on each of the fileservers, 

FS01 & FS02 and they will be synchronized one-way from the local replica FS01 

to the remote replica FS02 at 10pm nightly.  What this basically means to us is we 

should only maintain the PST files from a local windows PC at HQ, never a citrix 

desktop connection.  This will insure that your changes remain intact when 

replication occurs.   

Also, note that changes made locally on the HQ windows PC will be reflected after 

10PM nightly should you have need to open the outlook program from a citrix 

desktop session.  We caution you to only access the PST files from the citrix 

desktop sessions in read-only mode for intents and purposes. 

 

Using Outlook in the Office VS Outlook on Xen app (Remote access) VS at Home 

Outlook in the office is cached so all emails are downloaded to the PC for faster 

access/response time.  

Outlook on Xen app (Remote access) will be non-cached so it will be working off 

the Intermedia server in real time so slower but still acceptable.  

Outlook at Home is cached so all emails are downloaded to the PC for faster 

access/response time. 

If you have any questions please email the helpdesk for clarification.  
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EMAIL SETUP 

If you see this exact popup, outlook is asking for permission to get your user 

settings from the intermedia server. 

 

Check the “Don’t ask me about this website again” checkbox, then click the 

ALLOW button. 

INSTALLING SINGLE SIGN-ON – AT HOME TO USE EMAIL.  

1. Got to https://exchange.intermedia.net/aspx/Login.aspx provide your email 

address and password make sure “My Services” is checked.   

 
 

2. Click “DOWNLOADS & INSTRUCTIONS” 
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3. Click the “Learn more & Download” link.   

 
4. Select the correct version for your operating system.  32 or 64 bit. Then click 

the dropdown on the download prompt and click “Save as” 
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5. Find a location that will be easy for you to locate the setup, we are going to 

select the Desktop. 

 
6. Once downloaded to your desktop you can double click the setup program 

 
 

7. Click the Run button. 
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8. Click the “Install” button  

 
 

9. Once the install is complete review Intermedia Single Signon it works the 

same both inside and outside the office. 

 

Intermedia Single Sign-on 

Setting up your single signon you will witness this action each time you login to 

your system.  Follow these simple steps to configure your single signon. 

1. Provide your Sign-in address this would be your company email address 

2. Typically you would provide the same password you use to login to your 

computer.  However it may be different if you did not change your email 

password when you changed your login password.  See topic Changing 

Email Password 

 

3. Make sure to check the box for “Remember me on this computer” then 

click the “Sign In” button.  
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4. Click the “Start Outlook” button to load outlook.  Note the “Change 

Password” button to change your email password.   
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Creating a new Archive (PST) file in Outlook 

1. Select File menu in outlook   

 

2. Select Account settings 

  
3. Select Account settings again 

  

4. Select data Files  tab. 

5. Select  

6. Type the name of the archive 

  
7. Select OK 

8. Select OK 

9. An icon will appear in your Navigation Pane with the name you have 

created.  

  

ADDING OUTLOOK ARCHIVE (PST) FILE 

1. Select File Menu in Outlook   

2. Select Account settings  

 

 

3. Select Account settings again 

  

 

 

 

4. Select data Files  tab.  
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5. Select add  

6. A navigation window will open and you must then navigate to the Outlook 

folder on your H: drive. Locate the PST file. Select the file and then select 

OK. 

7. Repeat this process for adding additional PST files. 

 

Adding Department Mailbox 

1. Select File menu in Outlook  

2. Select the Account Settings button.   

 

  
 

3. Select account settings once more 

  
4. Select change 

  
5. Select the More Settings button 

6. Select the Advanced tab 

7. Select the Add button 

8. Enter the mail box name or the first few characters of the mailbox 

9. Select the mailbox from the list of close matches  

10. Select the OK button 

11.  Select the Apply button 

12. Select the OK button 

13. Select the Next button 

14. Select the Finished button 

15. Select the Close button. 
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Setting Up Email Signatures 

When opening email for the first time you will need to add your signature. 

1. Select the File tab 

 
2.  Select Options button 

 
3.  Select  the Mail button 

 
4. Select  icon 

 
5. Select  icon 

 
6.  Type the name of the new signature  

 

 

 

 

7. Type the signature 

 
 

8. Select New messages and replies if you would like the signature to be on the 

New messages and replies . 
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Then click  

 
 

Setting up Outlook Templates 

If you have Outlook templates and would like to attach the folder that you have 

created do the following. 

1. In Outlook from the File menu select the Options button from the list of 

menu items. 

2. Select the Customize Ribbon button.  

  
3. Check Developer from the list of Main Tabs 

 
4. Select the OK button 

 

5. Select the Developer tab that has now been added to the list of tabs at the 

top of the Outlook application window.  

 
6. Select the Choose Form button from the Developer tab 

  
7. Select User Templates in File System  
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8. Select  the Browse button and locate the folder that contains your templates 

 
9. Select the template and select OK  

 

CHANGING EMAIL PASSWORD 

1. From your desktop click on the shortcut for Intermedia Single SignOn 

 
 

2. You will be prompted to provide your Sign-in address and Password login 

using your email user and password.  

3. Single Sign-On window will appear click the Change Password button 

  

4.  Enter your current password and your new password and then enter your 

new password again for verification. 

5.  Then select the Change button. 

  

Your password should be the same as your domain password (the password you 

use to logon to the PC each day).   When you change your account password or 
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are required to change your login account password it is highly recommended 

that you change your Intermedia Outlook password too.   

Changing Outlook Column and Navigation view settings 

To change the size of your email columns click “View Settings” from the “View” 

Tab.  Make sure you have already adjusted your display resolution prior to 

changing outlooks view settings.These can be found in the section titled.  

CHANGING YOUR DESKTOP RESOLUTION.  

 

 

Then change the font options you want to enhance.  Hint Keep the “Column 

Font” and “Row Font” the same  

 

To Change the size of your Navigation Pane from the View menu select “Options 

from” the “Navigation Pane” button 
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Then select the “Font” button to change the font and or the size of the font this 

will have the effect of making your “Navigation Pane” larger or smaller to fit 

your preference.   

 

Printing 

 

FaxFinder 

Note: Faxfinder is a print destination that lets you fax a document to US 

based fax numbers.  This is likely rarely used any longer but it can be 

available.  The server name to use when configuring the faxfinder client 

is:faxfinder.elkshq.net 

 

Setting your default printer and adding printers 

To access or change your default printer you can double click on the SetPrint icon 

from the desktop.  It can look like either of these icons. 
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  or  

 

To set your default printer select the printer from the list of Available printers and 

click the Set as default button. 

 
 

To add a network printer select click the Connect… button at the bottom of the 

SetPrint screen. This is done for all network printers including Dymo and Oki 

data. 

 
 

The Select printer dialog will appear  

• Then select the building  

• Then select the floor and then the department. 

• Then select the printer and then select OK 

 
 

 

Printing from your local printer is quite simple if your local printer is set as the 

default.   

 

The application you are working with should recognize the printer that you have 

chosen as your default.  Yet you may still change which printer you wish to print to 

by using the print dialog from any application.  
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DYMO Label Printing  

Note:  DYMO labels are not specifically supported on Terminal or remote 

sessions you can cut and paste directly into the DYMO software to print 

labels.  It is however recommended that you use your local desktop to have 

full DYMO functionality especially when printing labels from the 

Membership system applications.   

 
Double click the DYMO icon on your desktop 

  
 

Select the label size you want, you can manually type the address information you 

want or from the Address Book tab within the DYMO application you can change 

the Address Book to your Outlook Contacts.   

 
Validate you have the correct DYMO printer selected. 

  
Click Print 

 
 

Printing to PDF 

Adobe Acrobat Pro Request to register. 

Acrobat Pro XI may ask you to register the application; this is nothing to 

be concerned about. All you will need to do is check the do not ask 

again and then select skip. If you are still having issues after performing 

the steps listed above please contact the helpdesk. 
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From any applications print dialog make sure to select the CutePDF Writer to 

print a PDF document.   

 
 

A Save As dialog box will allow you to name and select the location you wish to 

save the document.  

 

Printing to PDF from remote session  

Printing a pdf from a remote desktop connection initially can seem a little more 

complicated.  The reason being you can view printers that are local to the actual 

desktop(non-remote connection) and the printers that are available to the CTX or 

remote desktop.   

 

Always use one of the pdf printers that are local to the remote session avoid using 

the pdf printers that include session in the name.   
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Verify default outlook profile 

If you are unable to send PDF files from Adobe reader please validate that your 

Outlook profile is select as the  

1. Select Start icon 

  
2. Select Control Panel  

  
3. Select All Control Panel Items that appears after clicking the down arrow 

next to the Control Panel button.   

  
4. Select the Mail (32-bit) icon  

 
5. Select the Show Profiles… button 

  
6. Select  make sure your name is selected from the drop down

 

Select the OK button. 

MEMSYS Label Printing 

(MEMSYS Dymo label printing from Cixtrix Desktops and remote 

sessions is currently not supported by DYMO because smartpaste is 

not supported on terminal servers.)   

 
Dymo Label printing from Memsys is only supported  from your local 

PC desktop. 

   
Double click any one of the Membership DB applications provided on your 

desktop. 
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Enter your user information and click the Login button 

  
 

On the Main Menu under the Labels dropdown make sure you have selected the 

correct printer all label printers will have “oki” somewhere in the name.  

 
 

Now select the Reports Menu button  

  
 

Select the Report # you wish to use in this case you are printing labels so you wish 

to select 0100 – Individual Labels from the available reports.  

 

Change the Report Output to Oki Labels Printer 

  
 

Click the Submit button. 

 

You will be presented with the label form called Report 0100 Params – Labels 

provide the information or use one of the Quick Select options from the 

dropdown. 

 

Click the Execute button 
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As a precautionary measure a dialog box will appear with the number of labels you 

are about to print.  If the number does not adhere to what you believe is correct you 

have the opportunity to Cancel and check the parameters you provided on the 

Labels form. 

 
 

Print 1.5 Inch Labels - Mail Merge using Microsoft Word (Issue)  

New development concerning continuous label printing mail merge using 

Microsoft Word. 

 

As of September 1st, 2013 new mail merge templates created will not work with 

the Okidata targeted printers.  There are various postings on websites, non-really 

correct the problem.  We are posting to Microsoft websites hoping that they find a 

solution.   

 

In the meantime – copy a Word template that is known to work and connect to any 

new data source you might need to work with and paste in the new fields, but do 

not modify the page settings or printer settings as this will compromise your copied 

template.   

 A better scenario would be to use Access to develop your mail merge process 

instead of Word.  Access has more robust layout capabilities and does not put you 

through the treacheries that Word does to accomplish this relatively simple task. 

 

The Word mailings option to print the same labels on Avery stock labels does 

ironically work without incident, but mail-merge has been seriously compromised 

for continuous labels.   

 

The Word sheet fed mail-merge labels on the other hand continue to work fine. 
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Xerox or Canon Printing 

If you send a printout / report to a Canon (or Xerox) that has requires a billing code 

You will see this message below 

    

You will need to know a valid Depart ID 

 

 

If you wait a few seconds the Windows application will indicate not responding, 

until you confirm department ID/Password.    
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PrintKey 

PrintKey will automatically load when you log on to your PC.  To use Printkey 

simply press the Print Screen button located on your keyboard and the application 

will open. Output will be sent to the default printer designated at startup, unless 

you select an alternate printer in the Printkey dialogue box.   

 

Scanning 

 

Basic How to Scan Instructions 

Double click the VueScan icon located on your desktop.  

  
 

Note: Typical scanning devices are HP1530 or HP3050 printer/scanner in 

some cases you may have both.  The Source dropdown must contain the 

device you wish to scan from.   
 

 

Note your Source this will be your printer/scanner typically a M1530 or HP3050 

but can be different.   
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• Then make sure your source is set to your printer/scanner. 

• Mode: can be Flatbed or Doc Feeder in some cases you may not have a 

Flatbed option.   

• Media: should be set to what will best fit your needs. Your options are  

o Color photo – for color photos  

o B/W photo – for black and white photos 

o Line art – Line art for simple graphics 

o Text – for text only items 

o Magazine – for mixed text and graphic 

o Newspaper – for mixed black and white graphics and text 

• Then if you need to change the default folder location, select the Output tab 

and then select the icon and then navigate to the desired save location and 

select save. 

• Default location is My Documents\My Scans located on your H: drive 

• Now select Scan and the scan will be displayed when finished.  If using the 

Doc Feeder and not Flatbed you must click on the Last page button to 

end the scanning process otherwise it will wait for you to insert another 

page and click the Scan button once more.    
 

To restore application defaults such as file location and default name from 

the file menu in the ViewScan application select Default Options 
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OCR Scanning 

1. Double click the Readiris Pro 12 icon on your desktop 

  
2. Click the OCR Wizard from the left hand panel. 

  
3. Click the Next button on the OCR Wizard dialog box that will appear.  

Here you can check or uncheck the option to Enable Wizard on Startup. 

 
 

4. OCR Wizard will present you with several options make sure to check the 

options 

a. Scanner as the image source 

b. Page Deskewing. 
c. Click the Next button. 
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5. Leave the default scanner HP Scanjet 3600 series (TWAIN), click the Next 

button.  

6. Leave the default language to English, click Next 

7. Leave the default Microsoft Word 97, click the Next button 

8. Click the Go button once prompted to start the operation 

9. The document will be opened in Readiris Pro 12 with an Output File 

dialog will appear allowing you to name the file, as well as identify the file 

type as Microsoft Word.  You can browse to a specific location to save your 

file.  

10. If you encounter issues with the scanner settings such as the ADF (Auto 

Document Feeder), click the scanner link for the left side panel.  Check the 

following settings, make sure ADF is checked.  In the example the Scanner 

model is setup as HP LaserJet M1130(TWAIN), you may need to tray 

another model like “HP LaserJet M2727 MFP(TWAIN)” 
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Browsing the Internet 

 

Internet Explorer A.K.A IE 

 
 

When you open IE you will be directed to our home page www.elks.org/hq 

 

WEBSITE COMPATIBILITY ISSUES  

There may be instances where you are attempting to use specific websites and the pages of this 

website are not appearing correctly or features that should be available may not be working.  In a 

case like this you may wish to try changing your compatibility options in IE to find a mode that 

may be better suited to your website.   

1. Have IE open and then select the F12 button at the top of your keyboard.  You will then be 

presented with the following window at the bottom of IE. 
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2. You will then select the Browser mode tab. When you do you will see this window. 

 

3. You will then select what mode you would like IE to be in. For some sites you may want to 

use Internet Explorer compatibility view and for another site you may want Internet Explorer 

9 or lower may work better. 

BLOCKED WEBSITES  

If you receive a message such as the following while browsing the internet it means that this site 

is blocked for some specified reason.  If you have a legitimate reason to have access to this site 

you will need inform your supervisor who can then make a request to the IS department on your 

behalf.  On the Grand Lodge Intranet under IS News Read Article link “What to do if the 

internet browser returns a popup instead of the web page you selected”.  This will provide 

you with full instructions on how this is to be handled.  

 

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 46 of 102 

 

 

Hancock Pension Website – Allow full functionality 

To Allow Full Functionality of John Hancock Pensions Website: 

1. Click on Start button in lower left corner. 

2. Choose All Programs. 

3. Click on Java. 

4. Click on Configure Java. 

5. This will bring up this window 

 

6. Click on Security Tab. 
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7. Click on Edit Site List. 
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8. Click on the Add button 

 

9. Enter the following in the Location field:  https://www.jhancockpensions.com 

You’ll need to type it in because you can’t paste into this field. 
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10. After entering the address in the Location field click on the OK button. 

      

11. You will now see the web address in the Exception Site List. 

12. Click on OK and you’ll be able to access everything on the website. 

 

 

IE Favorites 

To access your favorites please click on the favorite’s button which 

looks like a star located in the upper right corner of IE a drop down list 

will be displayed showing your favorites. 

 
 

Trusted Sites Internet Explorer 

To add a site to your trusted sites 

1. Select Internet options 

2. Select Security tab. 

3. Select Trusted 

4. Select Sites 

5. Select add (you should be on the site you want to add) 
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Creating a short-cut from IE address bar 

1. Left click and hold the left most position of the address bar, this 

would be the Elks logo all the way to the left in the example. 

  
2. While holding down the left mouse button, drag and drop to your 

desktop a short-cut will be produced for the website you have 

selected. 
 

Reset IE (Internet Explorer) History 

If IE gets badly confused or is not behaving normally you can reset your IE history 

which can sometimes cause the application misbehave. 

1. Click the settings button located on the IE tool bar 

 
2. Select Internet options from the dropdown that appears 

3. Click the Delete button that located in the Browsing history area of the 

Internet Options popup 

 
 

4. Check all the boxes to clear all saved history for the browser, then click the 

Delete button 
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5. A message will appear at the bottom of the browser window indicating that 

“Internet Explorer has finished deleting the selected browsing history” 

 

IE – Reset Internet Explorer’s settings to their default condition 

Sometimes when you are getting strange behavior from the browser it is recommended resetting IE to 

its default settings.  Especially after there have been several modifications to the settings and you’re not 

sure which one is causing the issue?   

1. From the IE browser upper right hand corner click on the Settings button.  

 

2. Select Internet Options from the dropdown 
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3. Click on the  Advanced Tab then click the Reset button.  

 

How To Change your default search provider 

To change your default search provider do the following. 

1. Click on the settings button on your browsers tool bar 
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2. Select Manage add-ons 

 
3. Click the Find more search providers… link. 

 
4. Once the list of providers displays select one for your preferred search 

engines in the example Duck Duck Go is selected   
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5. Click Add to Internet Explorer  

 
6. Check the box for Make this my default search provider and then click the 

Add button.  You will have to close your internet browser to make it final.   
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FireFox 

Open the Mozilla Firefox browser from the shortcut on your desktop.  

  
 
When you open FireFox you will be directed to our home page 

www.elks.org/hq 

 

When prompted by Firefox to make Firefox your default browser 

please select NO. Letting it become your default will break other 

applications that depend on Internet explorer being your default 

browser. 

To clear your history in FireFox 
1. At the left top of the Firefox window, click on the Firefox button 

and then select Options  

2. Select the Advanced panel.  

3. Click on the Network tab.  

4.  In the Cached Web Content section, click Clear Now button. 

5.  Click the OK button to close the Options window.  
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Establishing trust for firefox – Firefox does not have trusted sites option like 

IE does.   

1. Click Options, then advanced, then view certificates 

 

2. Click the  Authorities Tab,  then the  Import button 

 

3. Navigate to folder on M drive as shown 
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4. Double click on firewall_root.cer file 

5. Check all the checkboxes and click OK 

 

 

 
To access your favorites please select the Firefox in the upper left corner 

and then select bookmarks. 
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Citrix Desktops & Applications 

Connecting to Citrix while on campus 

SOLOMON, RE and Adobe users will access the applications in the following 

manor. Select the desktop icon  and then enter your user name, password and 

domain if prompted for domain it is ELKSHQ. You will then select the desired 

desktop SOLOMON, RE or Adobe and the desktop will load. 

 
 

 

You may see this prompt if so click the link Skip to logon to bypass this warning.   

 
 

Login – provide your user name and login password which is the same as you 

would use to login to your Windows 7 desktop on campus.  
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Then you must select the desired desktop that you are allowed access to.  Keep in 

mind you will only see the desktops that are configured for your use.  
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Configuring Your Remote Desktop Experience 

Once you login to Citrix XenApp you can set the environment to your choosing.  Depending on how 

these are set it can affect the way your desktop looks and functions.  Below are the standard settings 

that are recommended for the optimal features of your desktops.   

1. Click the Settings button. 

 

2. Under User Experience located at the bottom of the Settings page make sure Window size:  is 

set to Seamless in the dropdown. 

 

Configuring your Citrix XenApp client Configuring your Citrix XenApp client Configuring your Citrix XenApp client Configuring your Citrix XenApp client setting your preferences setting your preferences setting your preferences setting your preferences     

Once you are logged onto your remote client click on the dropdown panel located at the upper middle 

of your screen.  If no such dropdown is available then see the previous section above where it explains 

how to set the Window size: 
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Citrix PreferencesCitrix PreferencesCitrix PreferencesCitrix Preferences    

1. Make sure Display is set to Scale to fit 

 

2. File Access should be Read and Write 

 

3. Mic & Webcam should be set to Use my microphone and webcam 
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Emergency Desktop access    

Should you be instructed to work from home.  

1. Select  

 
2. Enter your logon information and click the Log On button 

   
3. Select the Desktops tab 
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4. Click the Remote Desktop for general access to Office 2010 or a specific 

published desktop for Adobe Apps or Raisers Edge. 

  
A Remote desktop will load and you will be up and working in no time. 

 

Note: Emergency & Remote Access also requires a special remote logon 

token for Security. HR would have us also note that non-exempt employees 

must punch in and out as required normally at start and end of work 

sessions.   

 

 

Deployment 

Basic Maintenance 

We will be redeploying desktop images every 3 months. This allows us to update 

applications and to make sure your PC is running according to IT standards. Your 

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 65 of 102 

 

PC will be automatically defragged each day and ESET will auto update to insure 

that your PC is safe to use. PCs are also programmed to reboot each night.   

Microsoft patches will be applied according to IT change control needed. If you 

notice the computer FAN speeding up when the PC is extra busy, this is necessary 

to cool the CPU and is perfectly normal, the fan will return to normal when the CPU 

workload subsides.  

Before a Windows Deploy  

(We ask that you collect this configuration data in the event that the automated 

process fails to work for your PC, should that happen the helpdesk will assist with 

remediation.  The configuration data being collected would be used by the 

helpdesk staff to restore the rest of your settings) 

 

Open up Outlook and get snapshots or record of configured folders, all mailboxes, 

pst (Archive) files that you have configured.  This is a precaution should RES 

workspace manager fail to carry over your settings to the new desktop.  

 

 

Configured signatures and stationary can be found by doing the following  
 

1. Selecting the File tab in Outlook  

2. Click the Options button from the left side panel 

3. From the Outlook Options screen that appears click Mail button form the 

side panel 

4. Click the Signatures… button that is found on that screen.   
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5. Review and Record your signatures and stationary that can be found on 

these tabs.   

 

 

 

 

 

Stationary  
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Record File locations and Drives you have configured. 

File locations for recently used Documents will not be retained Word, Access, 

Excel, or any other application.  Make sure you know where your files are located 

using Windows Explorer.  
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You should have the following Network drive connections at your desktop. H:  K: 

M:  S: Record the drives you currently have so that you can make sure they are 

back after imaging.  

 

Verifying your Intermedia/Outlook password -IMPORTANT 

Logon to Intermedia.net 

https://exchange.intermedia.net/aspx/login.aspx?ClientType=WebMail 

And validate your email password if different than your login password it would be 

a good time to change your single signon password.  Typically the old password is 

the previous windows password. It is prescribed to change your outlook password 

anytime you change your windows logon password, if you do not this part can get 

real sticky and will prevent access to your email inbox.   
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Do you have custom Desktop Shortcuts? We suggest getting a print screen of the 

icons and layout. 

Do you have quick Launch files Icons and settings that may need to be recreated 

after a New deployment. 

Record the screen resolution noted on the desktop in the upper right hand corner – 

you will need this after deployment when you 1st login.  

Desktop Screen settings? Get screen captures of all of them and save them on a 

USB drive or network drive so you can refer to them. 

Always use the Logoff ICON located on the desktop 

 Do Not Use the Shutdown to logoff provided for by Microsoft Windows from the 

Start Menu. 

 

 

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 70 of 102 

 

 

After a Windows Deploy   

Set your preferred screen resolution  

You will need to configure your Intermedia  Single Sing-On  

1. Enter your email address xxx@elks.org 

2. Enter your email password should be the same as your domain 

password. 

3. Select logon change option to automatically logon. 

This is typically all you have to do when we redeploy the desktop image unless RES 

workspace manager has difficulty bringing back your user preferences. Should that 

happen use the notes you took to return all your preferences.  It is unlikely this will 

happen but we cover this just in case.   

You will need to validate you have your archive file and departmental or 

special mail boxes. 

 

You will need to validate your signatures to Outlook. 

Check your book marks in IE. 

Check that you have all your network drives. 

You will need to validate your quick launch icons 

 

Action Center 

You will also need to go to the Action center and perform the following steps. So 

that you do not get unnecessary system messages.   

1. Click the Windows Start button 

  
2. Click on Control Panel 
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3. Once in Control Panel click on the black down pointing arrow and select 

All Control Panel Items 

 
4. Select Action Center

 
5. Click on both of the  links show below  

Turn off messages about network firewall and  
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Turn off messages about Windows Backup 

Exit Control Panel once done.  
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Windows 7 

Introduction to Desktop  

Think of your screen as your DESKTOP. Your DESKTOP is what you now see on 

the screen (as shown below). 

 

Glossary of Icons: 
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Desktop Icons are missing or unusual 

Icons may display like this when you first log on. To fix you will need to delete 

these generic icons and log off.  Once you log back on your system 

the icons should then display correctly. If the icon issue does not 

resolve it may no longer be supported, contact the helpdesk. 

Most icons will find their place and remember where you placed them after a few 

logon and logoffs.  

Some icons are created dynamically by the logon script and WILL NOT 

remember their place between sessions.   

 

 

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 75 of 102 

 

Windows Task Bar 

The taskbar is the long horizontal bar at the bottom of your screen. Unlike the 

desktop, which can get obscured by open windows, the taskbar is almost always 

visible. It has three main sections:  

• The Start button  , which opens the Start menu.  

 
 

• The middle section, which shows you which programs and files 

you currently have opened and allows you to quickly switch 

between them.  

• The notification area, which includes a clock and icons (small 

pictures) that communicate the status of certain programs and 

computer settings.  

 

  
 

Opening Applications  

There are many ways to start an application; it is up to the user to find one or two 

that suit you. The most common ways are: 

 

1. By clicking on the START button, going to the PROGRAMS menu and 

locating the application in the list that appears.  

2. By double clicking with the mouse on a shortcut icon on the desktop if one 

has been created. 

 

Changing Window Size  

• To make a window fill the entire screen, click its Maximize button or 

double-click the window's title bar.  
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• To return a maximized window to its former size, click its Restore button  

(this appears in place of the Maximize button). Or, double-click the 

window's title bar.  

 

• To resize a window (make it smaller or bigger), point to any of the window's 

borders or corners. When the mouse pointer changes to a two-headed arrow 

(see picture below), drag the border or corner to shrink or enlarge the 

window.  

 

 

A window that is maximized cannot be resized. You must restore it to its previous 

size first.  

Pinning Programs to the Task Bar 

Go to the START menu (right mouse click on the application and select pin to 

taskbar).  
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CREATING SHORTCUTS 

1. Right mouse click on an empty part of the desktop, click on NEW  

2. Click on SHORTCUT  

 

 
3. In the dialog box that appears, navigate to the file that you want by clicking on 

the BROWSE button.  

4. When you have located the file you want to create a shortcut to, select the file 

and click on the OK button.  

5. Click on the NEXT button 

6. Type in the name of your shortcut and click on  the OK button 

7. Your shortcut will now appear on the desktop.  
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DELETING SHORTCUTS 

To delete a shortcut from the desktop, click and drag the icon to the RECYCLE 

BIN, release the mouse. This does not delete the file, folder or program the 

shortcut represents, it only removes the shortcut from the desktop.  

 

You can also click on the Shortcut icon once with the mouse to select it, then use 

the DELETE key on the keyboard. Using this method you will be asked to confirm 

the deletion, click on the YES button. 
 

ARRANGING ICONS ON THE DESKTOP 

Occasionally you will want to tidy the desktop up – perhaps everything needs to be 

alphabetical order, or you want to put an icon in a different location (by dragging 

and dropping it). The different options for arranging icons are by name, size, type 

and when last modified.  

 

To order your desktop icons by these options, right mouse click on any free spot on 

the desktop, when the shortcut menu appears select Sort by and then select your 

preference.  You can also arrange your desktop icons by right clicking on the 

desktop selecting View and then selecting Auto arrange icons; this has the added 

feature that it will retain the general arrangement snapping back into place if you 

try to move the icons.   

 

To increase or decrease the physical size of the icons on your desktop simply right 

click on an empty space of your desktop as previously indicated and choose one of 

the three available sizes Large icons, Medium icons (default) and Small icons.   
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REARRANGE ICONS ON THE TASKBAR 

You can rearrange and organize program icons on the taskbar, including pinned 

programs and running programs that aren’t pinned, so they appear in the order you 

prefer. 

 

 

SWITCHING BETWEEN WINDOWS 

If you open more than one program or document, your desktop can quickly become 

cluttered with windows. Keeping track of which windows you have open isn't always 

easy, because some windows might partially or completely cover others.  

 
Using the taskbar. The taskbar provides a way to organize all of your windows. Each 

window has a corresponding button on the taskbar. To switch to another window, just 

click its taskbar button. The window appears in front of all other windows, becoming the 

active window—the one you're currently working in.  

 

To easily identify a window, point to its taskbar button. When you point to a taskbar 

button, you'll see a thumbnail-sized preview of the window, whether the content of the 

window is a document, a photo, or even a running video. This preview is especially 

useful if you can't identify a window by its title alone. 
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Using Alt+Tab. You can switch to the previous window by pressing Alt+Tab, or 

cycle through all open windows and the desktop by holding down Alt and 

repeatedly pressing Tab. Release Alt to show the selected window.  

 

Using Aero Flip 3D. Aero Flip 3D arranges your windows in a three-dimensional 

stack that you can quickly flip through. To use Flip 3D:  

1. Hold down the Windows logo key  and press Tab to open Flip 3D.  

2. While holding down the Windows logo key, press Tab repeatedly or rotate 

the mouse wheel to cycle through open windows. You can also press Right 

Arrow or Down Arrow to cycle forward one window, or press Left Arrow or 

Up Arrow to cycle backward one window.  

3. Release the Windows logo key to display the front most window in the 

stack. Or, click any part of any window in the stack to display that window.  
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Flip 3D is part of the Aero desktop experience. If your computer doesn't support 

Aero, you can view the open programs and windows on your computer by pressing 

Alt+Tab. To cycle through the open windows, you can press the Tab key, press the 

arrow keys, or use your mouse.  

 

 

ARRANGING WINDOWS 

Now that you know how to move and resize windows, you can arrange them 

however you like on your desktop. You can also have Windows automatically 

arrange them in one of three ways: cascading, vertically stacked, or side by side.  

 

 
To choose one of these options, open some windows on your desktop, then right-

click an empty area of the taskbar and click Cascade windows, Show windows 

stacked, or Show windows side by side. 

Arranging windows using Snap  
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Snap will automatically resize your windows when you move, or snap, them to the 

edge of the screen. You can use Snap to arrange windows side by side, expand 

windows vertically, or maximize a window.  

To arrange windows side by side  

1. Drag the title bar of a window to the left or right side of the screen until an 

outline of the expanded window appears.  

2. Release the mouse to expand the window.  

3. Repeat steps 1 and 2 with another window to arrange the windows side by 

side.  

 
To expand a window vertically  

1. Point to the top or bottom edge of an open window until the pointer changes 

into a double-headed arrow.  
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2. Drag the edge of the window to the top or bottom of the screen to expand the 

window to the entire height of the desktop. The width of the window doesn't 

change.  
 

 
 

To maximize a window  
1. Drag the title bar of the window to the top of the screen. The window's 

outline expands to fill the screen.  

2. Release the window to expand it to fill the entire desktop.  
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VIEW DESKTOP INSTANTLY 

By clicking this little side panel in the notification area you can minimize all open 

windows view the desktop.  To return to the previous view simply click it again.    
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Fonts – Windows 7: All fonts that are included with windows 7 are installed. 

Users can not install fonts. Applications that are installed will include any and all 

included fonts. Fonts are licensed and installing unlicensed fonts is copyright 

infringement. 

Working With Files 

CHANGE THUMBNAIL SIZE AND FILE DETAILS 

You can change the size and appearance of your files and folders by using the 

Views button located on the toolbar of every open folder. You have several options 

to choose from Extra Large Icons, Large Icons, Medium Icons to name a few.   

 

 

ARRANGING FOLDERS 

When you open a folder or library, you see it in a window. The various parts of this 

window are designed to help you navigate around Windows or work with files, 

folders, and libraries more easily. Here's a typical window and each of its parts:  

PDF compression, OCR, web optimization using a watermarked evaluation copy of CVISION PDFCompressor

http://www.cvisiontech.com


Page 86 of 102 

 

 

 

SAVING RENAMING DELETING AND MOVING FILES 

PLEASE REMEMBER TO SAVE FILES TO A NETWORK DRIVE OR A 

USB DRIVE AND TO NEVER SAVE FILES TO THE LOCAL PC 

DESKTOP OR C: DRIVE AS THEY ARE NOT BACKUPED AND CAN 

NOT BE RESTORED. Please save files to the Network drives, such as H 

(Personal network drive space) K Department folders M is for all users use at 

your own risk. S drive special Projects. 

 

Renaming Files and Folders  
There are a number of ways to rename files and folders. You can rename by using 

the FILE menu, left mouse button or right mouse button.  

 

Method 1 - Using the FILE Menu  
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1. Select the file or folder you wish to rename;  

 

2. Click on the File menu and select Rename 

 

  

3. Type in the new name. NOTE: If you are renaming a file you must keep the 

same file extension (e.g. “.doc”) as it had, or the file will no longer be 

associated with the program that created it;  

 

4. To finalize the renaming operation press the Enter button on the keyboard 

or CLICK away from the rectangle that surrounds the file or folder name. 

 

Method 2 – Using the Right Mouse Button  
1.  Select the file or folder you wish to rename;  

 
 

2. Click the right mouse button while still pointing to the file;  

3. Select RENAME from the shortcut menu;  

4. Type in the new name (if renaming a file, remember to include the file 

extension (e.g. “.doc”);  

5. To finalize the renaming operation press the Enter key on the keyboard or 

click away from the rectangle that surrounds the file or folder name.  

 

 

Method 3 – Using the Left Mouse Button  
1. Select the file or folder you wish to rename;  

2. Wait a moment then click again (not in quick succession like a double click). 

A surrounding rectangle will appear around the name; 

3.  Type in the new name (if renaming a file, remember to include the file 

extension (e.g. “.doc”);  

4. To finalize the renaming operation press the Enter key on the keyboard or 

click away from the rectangle that surrounds the file or folder name.  
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Deleting Files and Folders  
When you delete a folder, the folder and its entire contents (any files or sub-

folders) will also be deleted. When you delete a file, the whole file and its contents 

are deleted.  

 

YOU SHOULD NEVER SAVE FILES TO YOUR DESKTOP OR C: DRIVE AS 

THEY ARE NEVER BACKED UP AND CAN NOT BE RESTORED. 
 

To delete a file or folder:  
• Right-click the file or folder that you want to delete, and then click Delete.  

 
NOTE: To permanently delete a file or folder (i.e. to avoid sending a file or folder 

to the Recycle Bin), hold down the SHIFT key, press delete on the keyboard. 
 

 

Moving Files around to different locations or drives 

Method 1 – Using CUT and PASTE  
Cutting and pasting are typical Windows functions. Cutting means moving 

something (this can be a file or folder if working in Windows Explorer, or text, 

graphics, objects if actually working inside an application). 

 

 Pasting is the action of bringing back the cut item in its new location. There are 

two different methods of cutting and pasting inside Windows Explorer and these 
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are well worth learning as they are basically the same in every Windows program 

you work in.  

 

1. To cut a file(s) or folder(s), first select the file(s) or folder(s) and then 

choose one of the following:  

• Click on the EDIT menu, select the CUT function;  

• Keyboard shortcut, CTRL + X;  

• Click on the selected item with the RIGHT mouse button and select 

“CUT” from the shortcut menu  

 

2. To bring back the file(s) or folder(s) in the new location, navigate to the new 

location then paste using one of the following:  

• Click on the EDIT menu, select the PASTE function;  

• Keyboard shortcut, CTRL + V;  

• In the position where you want the item to be pasted, click with the 

RIGHT mouse button and select “PASTE” from the shortcut menu. 

 

Method 2 – Dragging and Dropping  
1. In the right pane, select the file(s) or folder(s) you want to move;  

2. Manipulate the FOLDER LIST on the left side of the Windows Explorer so 

that it shows the new location. Make sure you use the scroll bars and the + 

and – (collapse and expand buttons) to navigate, do not click on the names 

of the drives or folders as you will change to that drive or folder and lose 

your selection in the RIGHT pane;  

3. Click and drag the selected file(s) or folder(s) from the RIGHT pane, over to 

the FOLDER LIST on the left. Release the mouse button when the target 

folder is highlighted (active);  

4. Your file(s) or folder(s) will now appear in the new area  

 

Method 1 – Using COPY and PASTE  
Like cutting, copying is a typical Windows function. Copying does not damage or 

remove the selection being copied. To place the copy in a new location is known as 

pasting (and is done the same way as previously described).  

 

There are three different methods of copying in Windows Explorer and, as 

mentioned previously, these are well worth learning as they are basically the same 

in every Windows program you work in.  
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1. To copy file(s) or folder(s), first select the file(s) or folder(s) and then 

choose one of the following:  

• Click on the EDIT menu, select the COPY function;  

• Keyboard shortcut, CTRL + C;  

• Click on the selected item with the RIGHT mouse button and select 

“COPY” from the shortcut menu.  

 

2. To place a copy of the file(s) or folder(s) in the new location, navigate to the 

new location then paste using one of the following:  

• Click on the EDIT menu, select the PASTE function;  

• Keyboard shortcut, CTRL + V;  

• In the position where you want the item to be pasted, click with the 

RIGHT mouse button and select “PASTE” from the shortcut menu. 

 

Method 2– Dragging and Dropping  
1. In the RIGHT pane, select the file(s) or folder(s) you want to copy 

2.  Manipulate the FOLDER LIST on the left side of the Windows Explorer so 

that it shows the new location. Make sure you use the scroll bars and the + 

and – (collapse and expand buttons) to navigate, do not click on the names 

of the drives or folders as you will change to that drive or folder and lose 

your selection in the RIGHT pane;  

3. Hold down the CTRL key on the keyboard and at the same time, click and 

drag the selected file(s) and/or folder(s) over to the FOLDER LIST on the 

left, and drop it where you want to copy the file(s) and/or folder(s) to. 

Before dropping make sure the target folder is highlighted (active). Also 

make sure you release the mouse before you release the CTRL key when 

dropping.  

4. Your file(s) and folder(s) will now appear in the new area  

 

FOLDER AND FILE ATTRIBUTES  

Files and folders have property sheets which display information such as size, 

location, and the date the file or folder was created. When you view the properties 

of a file or folder, you can also get information about the:  

• Type of file;  

• Size of file;  

• Name of the program that opens the file;  

• Last time the file was modified or accessed.  
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If looking at the properties of a folder:  

• Number of files and subfolders contained it contains; and  

• Space taken up by those files and subfolders  

To determine the attributes of a file or folder:  
1. Select the file or folder;  

2. Right click on the file or folder;  

3. Select Properties from the shortcut menu. The  

PROPERTIES dialog box will open  

 

The PROPERTIES dialog box gives you the following 

information:  

 
 
Type of File: tells you what program your file was created in (e.g. Word)  

Opens with: tells you what application (software) the file will open in  

Location: the path name for the file  

Size: the size of the file  

Size on disk: how much room the file is taking in storage  

Created: the date and time the file was originally created 

Modified: the date and time the file was last modified  

Accessed: the date and time the file was last accessed  

Hidden: Usually hidden files are program or system files that should not be 

deleted or changed. Hidden files and folders will appear dimmed within 

WINDOWS EXPLORER to indicate they are not typical items.  
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Read Only: A read only file contains information you can read but not change, like 

a printed book. A read only file on your computer is a file you can open, read or 

print but not make any changes to. 

 

 

 

ZIPPING (Compressing files) AND UN-ZIPPING FILES 

Often you may need to send a group of files via email or some other method and 

wish to reduce the size of the file.  To compress a group of files do the following.   

 

Zipping – Compressing a group of files 
1. Using Windows Explorer locate a group of files that you wish to send. 

While holding down the shift key on the keyboard left mouse click on the 

1st file then left click on the last file you wish to send.  Once the files are 

selected continue holding down the shift key and right mouse click on the 

last file in the list. 

   
2. Once at menu appears select Add to “filename.zip” in the example below 

the file is called RF.zip.  Keep in mind that if the file already exists it will 

add what you have selected to the existing zip file.  If the old zip is not 

needed and you only wish to zip your currently selected files you must move 

or delete the existing zip file prior to compressing.   
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3. In the directory that you are currently in you will see you’re newly created 

zip file in this case RF.zip. You may attach this file to email or copy to 

some other location so that it may be un-zipped by your intended recipient.  

See instructions below on un-zipping.   

 
 

Un-Zipping – Extracting Files 
Once you have received a compressed file typically in a zip format but there are 

others.  You must extract or unzip the file so that you can access those files.   

1. Once the file is in a desired folder or device use Windows Explorer to locate 

the file (It’s good practice to place the zip file on a usb or in a new folder of 

its own, so once unzipped the contents are easily identifiable)  

 
 

2. Right mouse click on this file select 7-Zip and Extract Here, there is an 

option to extract to “location\” in the example below it shows “RF\” this 

will dynamically create a sub folder in your current location and extract the 

files into that sub folder.  
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3. Now along with the original zip file are the fully extracted files that are fully 

accessible by the user. 

 
 

 

RECOVER FILES FROM THE RECYCLE BIN 

1. Open the recycle bin  

2. Do one of the following:  

a. To restore a file, click it, and then, on the toolbar, click Restore this 

item.  

b. To restore all of the files, make sure that no files are selected, and 

then, on the toolbar, click Restore all items.  
 

The files will be restored to their original locations on your computer. 
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Notes  

• If you delete a file from a location not on your computer (such as a network folder), the file will be 

permanently deleted rather than stored in the Recycle Bin.  

 

Emptying the Recycle Bin:  
1. Double click the Recycle Bin on the desktop  

2. Click the Empty the Recycle Bin button located on the toolbar 

3. You will be prompted Are you sure you want to preeminently delete 

these items? Click the Yes button.  

 

BURNING CDS AND DVDS 

Burning a CD/DVD with external Drive (Must have access to externally 

attached RW drive 

 
1. Insert the CD/DVD USB drive into a USB port 

2. Insert blank CD/DVD media 

 

3. An AutoPlay window will appear a few seconds after you insert a blank CD 

or DVD select Burn a disc using CDBurnerXP, then continue with step 

5. 
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Or you can manually launch from the Start Menu  and  select 

CDBurnerXP as show on next page.  

 

4. If your launched the application from the Start menu select the Data disc 

option.   

5. In the navigation window navigate to the files or folders you would like to 

burn. You can drag files into the lower right Pane or you can select on 

the individual files and click the Add button.   
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6. Select the drive that has the media  

 
 

 

REMOTE CONNECTIONS 

TESTING YOUR REMOTE LOGIN FROM INSIDE THE OFFICE NETWORK 

It is always a good idea to make sure you can actually connect to your remote login 

prior to needing it offsite.  You can test this from inside our network using the 

browser.   

https://ctxapps.elks.org/ 

 

You will then be taken to the login screen where you will use your user name, 

network password and MP-1 password obtained from your MP1 Token app.   
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VPN USERS 

Enter ctxapps.elks.org in the address bar of IE and select enter 

 

You will then see the following window. 
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You will then enter your user name and domain password (the one you use every 

day when you log on in the office) and the token that is generated from the MP-1 

application on the phone or device that you have installed it on. 

 

Select the Desktops tab 

 
Then select the Remote Desktop button. 

 

 
Printers available on your remote desktop – Typically the office network 

printers and any printer connected to the PC you are connecting from. You will not 

have the 1530 or 3050 on your work desktop since that is NOT a network service.  

Also note that if we are operating in emergency DR mode, there will not be any 

network printers available.   

Emergency user logon 

Internet access as well as firewall issues and other unforeseen issues could affect the list of available 

services list below. Please keep this in mind when working.  

1. At the logon screen select the ALT, CTRL and Delete buttons on your keyboard. 

2. For the user name please type name of your PC it will be on a label on the top of your PC, user 

name example: IS06\emergencyuser and the password is nicedaytohaveanemergency!  

3. You will be able to access Internet explorer, for your email needs and internet access. To do so 

please select the Start icon then select All programs now select the Internet Explorer icon. 

4. To access web-mail type the following  address in the address bar of Internet Explorer: 

https://exchange.intermedia.net/aspx/Login.aspx 

5. Now type your email address and password then select login. 

6. For Paylocity: https://login.paylocity.com/escher/escher_webui/views/login/login.aspx 

7. For elks.org: http://www.elks.org/ 

8. For Intacct: http://us.intacct.com/ 

9. You will be able to access Microsoft Office products by selecting the Start icon then select All 

programs then select the folder called Microsoft Office now select the application you wish to 

open. YOU WILL NEED TO SAVE ALL/ANY FILES YOU CREATE ON A USB DRIVE. DO NOT SAVE 

TO THE PC AS YOU WILL NOT BE ABLE TO ACCESS THE FILES LATER.  

10. To log off please select the Start icon then select shutdown. 
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Printing to a printer connected to your PC will be available. 

The Wifi network should be available for use with handheld devise as well as Laptops. 

The Intacct website will be available to accounting. 

Sites you may not be able to access are Elks.org, CLMS, and or Memsys during this time. 

Tasks you will not be able to perform are print to a network printer, print labels, access department 

drives, access your H drive, use Raisers Edge,use Solomon,  use Adobe desktops and Check scanning. 

GETTING ASSISTANCE 

HELP AND SUPPORT 

Help is always available as you learn about the different functions on your 

computer. You can access the HELP AND SUPPORT functions by clicking on 

the START button and selecting HELP AND SUPPORT. The HELP AND 

SUPPORT CENTER dialog box will appear:  
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Find the support you need by either clicking on a topic under the section called 

NOT SURE WHERE TO START? or type what you are looking for in the 

SEARCH field and press ENTER. A list of matching criteria will be compiled. 

Click on the underlined topic to display the full help text.  

NOTE: You can also hit F1 on your keyboard at any time to launch the HELP 

menu. You need to click on the desktop first then press F1 

 

 
 

TEAMVIEWER  

We will be supporting Grand lodge users the way we support about 2000 lodges 

using TeamViewer. We asked by the Help Desk to open TeamViewer perform the 

following steps. 

 
1. Double click the TeamViewer icon 

  
 

2. Provide the IT support staff with following information from the 

TeamViewer screen the support staff will need to know both Your ID and 

the associated Password this can be different each time TeamViewer is 

launched.  

   
 

3. The password will change each time you open TeamViewer. 

4. You will need to be present until the work is finished. 

 
 

If your questions have not been covered in this document or the outcome is 

not consistent with the instructions please contact the help desk: 

helpdesk@elks.org or call 4746 

 

No support for laptops, home computers, pads, all cell phones (with the exception 

of getting VPN working) and (configuring outlook using single sign on for 

windows.) Outside of making sure the wifi access points work, we do not have 
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enough staff to provide help for HQ WIFI connections for wifi while traveling 

and connecting back in via VPN. If you require outside computers, make 

arrangements with best buy geek squad or others to provide the help we cannot 

cover.  We’d like to help but we just don’t have the man power to cover the 

world. 
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